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GUIDE
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ANNUAL ENROLLMENT: 
Oct. 23 through Nov. 3, 2023 1



Annual Enrollment is your opportunity to make changes to your elections and/or your covered dependents for the next plan year. Take time to evaluate your 
current coverage, your personal situation, and the benefit options available to you to determine if you need to make any changes to your elections. 

If you do not make any changes during Annual Enrollment, you may only change your elections during the plan year if you experience a qualified life event  
(e.g., marriage, birth of a child). If you experience a qualified life event, you have 30 days from the date of the event to enroll and/or make changes to  

your elections (60 days for birth or adoption only).

Oct. 23, 2023: Annual Enrollment for the  
2024 plan year begins

Nov. 3, 2023: Last day to submit Annual 
Enrollment elections

Jan. 1, 2024: Effective date of most Annual 
Enrollment elections

	■ Beginning on Monday, Oct. 23, log on  
to the EIX Benefits Connection site at  
eixbenefits.com.

	■ Look for the Annual Enrollment tile on  
the home page and click on the Go button  
to review your current elections.

	■ To make changes to your elections, click  
on the Make Elections button. On this 
screen you can change your elections and  
add or update family members. 

	■ Upon completing the enrollment, you’ll see  
a confirmation screen. You can download  
and print a confirmation statement for  
your reference. 

	■ You may make changes to your elections  
as many times as needed until Annual 
Enrollment ends on Friday, Nov. 3. 

	■ Read through helpful reference materials  
and decision support tools available on  
EIX Benefits Connection — see page 16  
for details. 

	■ Connect with an EIX Benefits Connection 
representative. Visit eixbenefits.com to use 
the Chat Online or Contact Us features,  
or call (866) 693-4947 to speak to a 
representative. Representatives are 
available Monday through Friday,  
7:30 a.m. to 5:30 p.m. Pacific time.  
Please be aware that wait times may 
increase during Annual Enrollment.

HOW TO SUBMIT YOUR ELECTIONSKEY DATES NEED HELP?

ABOUT THE 2024 ANNUAL ENROLLMENT 
Oct. 23 through Nov. 3, 2023

Your Benefits Enrollment Guide provides a summary of our health and welfare plans and programs, the tools and resources available to you,  
and important details about enrolling.

This guide is a summary of changes for 2024 and should be reviewed and retained for future reference.
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3

2 0 2 4  B E N E F I T S  E N R O L L M E N T  G U I D E

WHAT’S CHANGING IN 2024?
For a detailed side-by-side comparison of all medical, dental and vision plan options, refer to the 2024 Health Plans Comparison. Visit eixbenefits.com and click on 
Library > Documents & Forms > Reference Materials > 2024 Health Plans Comparison. This helpful document can help you quickly compare key plan features, 
such as deductibles, copayments and coinsurance.

Edison is consolidating the number of plan offerings to eliminate plans that are duplicative or have low enrollment, while  
still providing comprehensive coverage options. The 2024 options are designed to closely match our current offerings and  
will streamline from 4 plan providers to 2 plan providers. 

Kaiser Permanente will continue to be a plan provider. Aetna will replace the plans offered by Blue Shield, Health Net,  
and United HealthCare. The new Aetna plans will provide access to a broad health plan provider network that includes 
approximately 96% of the providers currently used by our non-Kaiser plan members.

Based on your coverage in 2023, you will automatically be mapped to a default plan for 2024. You may choose to remain  
in the default plan, or you can select another medical plan during Annual Enrollment.

If you were non-Medicare eligible and had this  
medical plan in 2023… You will be automatically mapped to this plan for 2024…1

Kaiser Permanente EPO Kaiser Permanente EPO
Blue Shield PPO (90/70, 80/60, 70/50 options)
Health Net PPO

Aetna PPO — Choice POS II (PPO 100%)

Health Net HMO
United Healthcare HMO

Aetna Nationwide EPO — Open Access Aetna Select (100%)

If you were Medicare-eligible and had this  
medical plan in 2023… You will be automatically mapped to this plan for 2024…1

Kaiser Permanente Senior Advantage MAP Kaiser Permanente Senior Advantage MAP
Health Net Seniority Plus MAP
UnitedHealthcare MAP

Aetna HMO MAP — Medicare (P01) HMO (MAP 100%)

Blue Shield PPO
Health Net PPO

Aetna PPO MAP — Medicare (C04) ESA PPO (MAP 100%)

1 Italicized text indicates Aetna plan names.

BENEFIT PLAN CHANGES

Medical Plan Options

http://eixbenefits.com
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Prescription Drug 
Formulary  
(Pre-Medicare plans only)

A formulary is a list of brand name and generic prescription drugs covered by the pharmacy benefit manager. Drugs included 
on the formulary are based on clinical appropriateness of the drug, and not the cost.

Currently, Kaiser Permanente uses a closed prescription drug formulary and will continue to do so for 2024.

Beginning in 2024, the pharmacy coverage through Express Scripts for pre-Medicare participants in the Aetna plans will  
use a closed formulary. Participants who are using prescription drugs not included in the closed formulary will be notified  
by Express Scripts in late 2023. Participants will have until April 1 to work with their doctor to update their prescription to a 
preferred alternative.

Effective Jan. 1, 2024, the dual coverage restriction on medical plan coverage will be removed and an individual can enroll for 
medical plan coverage as both an Edison employee/retiree and as a dependent.

Coverage as a Retiree  
and Dependent 
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2024 Benefits  
Changes FAQs

Medical Plan Lineup

What medical plan options will be available starting in 2024?

In 2024, the medical options for pre-Medicare retirees and their eligible dependents will include:
	■ Aetna Nationwide EPO
	■ Aetna PPO
	■ Kaiser Permanente EPO

The medical options for Medicare-eligible retirees and their eligible dependents will include:
	■ Aetna HMO MAP (available in select counties throughout the U.S.)
	■ Aetna PPO MAP 
	■ Aetna PPO Coordinated Plan
	■ Kaiser Permanente Senior Advantage MAP

About the medical plan types:
	■ Preferred Provider Organization (PPO) — After you meet an annual deductible, both you and the plan each pay a 
percentage of your eligible expenses, known as coinsurance. Not all services require you to meet your deductible first,  
such as in-network preventive care. You can receive care from any provider, but when you see an in-network provider,  
your out-of-pocket cost will almost always be less.

	■ Health Maintenance Organization (HMO) — There is no annual deductible and most eligible expenses require you  
to pay a flat dollar amount, known as a copay. You must select a primary care physician (PCP) who will coordinate all  
of your care. All medical services must be received from your HMO’s network of providers.

 – Geographic Service Area: You and any covered dependents must live and receive medical care within the plan’s 
geographic service area if you enroll in an HMO plan. Out-of-area medical services may not be covered, resulting  
in your financial responsibility for any costs incurred.

	■ Exclusive Provider Organization (EPO) — Like an HMO, an EPO has no annual deductible and most eligible expenses 
require you to pay a copay. Depending on the EPO you select, you may or may not need to select a primary care physician 
(PCP) to coordinate your care. It’s important to remember that if you have an EPO, you are responsible for ensuring that all 
of your medical services are received from your EPO’s network of providers. 
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2024 Benefits  
Changes FAQs
(continued)

Medical Plan Lineup 
(continued)

I am Medicare-eligible but my dependents are not. Do I have to select a specific plan for my dependents?

If you and a covered spouse/registered partner are a combination of Medicare-eligible and pre-Medicare, you must enroll in 
medical plans with the same carrier.

If retiree is Medicare-eligible and enrolls in:
Select from the following plans for pre-Medicare dependents  
(all pre-Medicare family members must be enrolled in the same plan option):

Kaiser Permanente Senior Advantage MAP Kaiser Permanente EPO
Aetna HMO MAP Aetna Nationwide EPO 

Aetna PPO
Aetna PPO MAP Aetna Nationwide EPO 

Aetna PPO
Aetna PPO Medicare Coordinated Plan Aetna Nationwide EPO 

Aetna PPO

If retiree is pre-Medicare and enrolls in:
Select from the following plans for Medicare-eligible dependents  
(all Medicare-eligible family members must be enrolled in the same plan option):

Kaiser Permanente EPO Kaiser Permanente Senior Advantage MAP
Aetna Nationwide EPO Aetna HMO MAP (if available in geographic area) 

Aetna PPO MAP 
Aetna Medicare Coordinated Plan

Aetna PPO Aetna HMO MAP (if available in geographic area) 
Aetna PPO MAP 
Aetna Medicare Coordinated Plan

I will be mapped to one of the new Aetna plans. Do I have to change my health care provider? 

Most members currently in a non-Kaiser medical plan will not have to change providers. Approximately 96% of the providers 
currently used by the members in our non-Kaiser plans will be in-network providers for our Aetna medical plans in 2024. To 
check if your provider is in the Aetna network, visit the Aetna microsite at www.aetnaresource.com/n/Edison.

I will be in one of the new Aetna plans. Do I need to inform my health care provider of the change? 

You will receive a new plan ID card from Aetna in December. Inform your health care provider that you will be changing 
medical plans effective Jan. 1, 2024. Your health care provider will need the information on your new ID card to submit claims 
for coverage. 

http://www.aetnaresource.com/n/Edison
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I’m currently enrolled in Kaiser Permanente. Will I need to take action during Annual Enrollment? 

Employees enrolled in Kaiser Permanente will automatically retain Kaiser Permanente coverage, so if you wish to remain in  
the Kaiser Permanente plan, you do not need to take action. However, we encourage you to review your new options and 
costs outlined on your Annual Enrollment online offerings to ensure you’re enrolling in the most appropriate plan that meets 
the needs of you and your family. 

What happens if I’m enrolled in a plan that will no longer be offered in 2024, but I am still receiving medical 
treatment or hospitalization under that plan? 

With these types of transitions, there is a feature referred to as transition-of-care (TOC) which may permit you to utilize  
out-of-network providers for a limited period of time. To initiate TOC, you must complete a Transition Coverage Request  
form which can be found at eixbenefits.com > Library > Plan Information > 2024 Annual Enrollment.

What is the purpose of having a closed formulary?

The goal of adopting a closed formulary is to provide affordable access to clinically sound, high-quality, and affordable 
pharmaceutical products. 

How can I find out what drugs are on the formulary?

During Annual Enrollment, the Express Scripts member website (www.express-scripts.com) will be updated to include the list of 
drugs on the formulary.

How often will the drugs on the formulary be reviewed/updated?

Throughout the year, an independent panel of doctors and pharmacists review and compare medications available. The 
formulary list may change if the panel finds that multiple medications to treat the same condition are equally safe. 

How will I know if a drug that I’m taking is on the formulary? 

As part of the transition to a closed formulary, Express Scripts will notify you in the fall of 2023 if you are taking a drug that 
will not be included in the formulary in 2024. The letter will provide you with a list of preferred alternative drugs and suggest 
that you work with your health care provider to transfer to one of the preferred alternatives covered on the formulary. 
Beginning Jan. 1, 2024, you will have 90 days to work with your provider to update your prescription to a preferred alternative. 
If your prescription is not updated by April 1, the prescription will not be covered by Express Scripts and you will have to  
pay the retail price for the prescription. If your provider determines it is clinically justified for you to continue taking a drug 
excluded from the formulary, the provider can request an exception through Express Scripts and the request will be reviewed.

If a drug you are taking is removed from the formulary during a future update, you will be notified by Express Scripts and 
provided with a list of preferred alternative drugs. You can then work with your health care provider to transfer to one of the 
preferred alternatives on the formulary. 

2024 Benefits  
Changes FAQs
(continued)

Medical Plan Lineup 
(continued)

Express Scripts Formulary

http://eixbenefits.com
http://www.express-scripts.com
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ENROLL ON THE GO: Complete Annual Enrollment On Your Mobile Device
Remember, you can conveniently submit your Annual Enrollment elections online using your mobile device. You must have 
a username and password registered on eixbenefits.com before you can register on the app. 

Get Started
	■ Download the Life@Work app from the Apple App Store or Google Play. 
	■ Log in with company code SCE03. 
	■ Enter your username and password to authenticate your identity. 
	■ Verify your device via email or mobile number. 
	■ Once your device has been registered, create an Access PIN. You can then set permissions for biometric authentication 
or notifications. 

	■ During Annual Enrollment, click on the Benefits Website tab on the app Home screen, then click on the Annual 
Enrollment tile to make your elections.

My spouse is an Edison employee and I am an Edison retiree. Can we now cover each other as a dependent under the 
other’s medical plan?

Currently, if you have a dependent (e.g., spouse, registered partner, or child) who also works at Edison or is an Edison retiree, 
they cannot be enrolled for medical coverage as both an employee/retiree and dependent.

Effective Jan. 1, 2024, you and/or your spouse/registered partner can enroll for coverage as both an Edison employee/retiree 
and as a dependent.

Are there advantages to covering each other?

Not necessarily. You should carefully review how benefits are coordinated between the two plans, as having the two plans 
may not always provide additional coverage. For example — the plan that covers you as retiree is considered primary and 
should be billed first. You should also calculate the premium costs for applicable coverage scenarios to see if this makes  
sense for your family situation. 

2024 Benefits  
Changes FAQs
(continued)

Coverage as a Retiree  
and Dependent

http://eixbenefits.com
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IMPORTANT REMINDER: Review and Update Your Dependent’s Social Security Number
During Annual Enrollment, take a moment to review the Social Security number on file for your dependents and update if 
necessary.
	■ Log in to eixbenefits.com.
	■ Click on your name in the upper right hand corner of the page to view your profile.
	■ Select the Dependents tab and review the information displayed.
	■ If your dependent’s Social Security number is blank or incorrect, click on the Change button, enter the correct Social 
Security number and click on Save.

http://eixbenefits.com
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IMPORTANT QUESTIONS AND ANSWERS
Following are some common questions and answers. Other important information about our benefits and enrollment will be provided online during your election  
process.

Typically, for your healthcare coverage you only need to take action during Annual Enrollment if you want to change plans  
or elect new coverage for you and eligible dependents since your coverage will continue into the next year if you do not  
make any changes. However, due to the upcoming changes in medical plan providers in 2024, you are strongly encouraged  
to review your benefit coverages, monthly premiums, copays, and other out-of-pocket expenses to ensure you are enrolled  
in the plans most appropriate for you in 2024.

Based on your coverage in 2023, you will automatically be mapped to a default medical plan for 2024. You may choose to 
remain in the default plan, or take action during Annual Enrollment to select a different medical plan. 

DO YOU NEED TO TAKE  
ACTION DURING ANNUAL 
ENROLLMENT?

WHAT’S THE DEFINITION OF 
AN ELIGIBLE DEPENDENT?

TIP: Don’t forgot to consider how your coverage may be impacted by future qualified life events (e.g., covered dependent 
child moving out of state, etc.).

An eligible dependent can be any one of the following individuals:
	■ Your legally married spouse or registered partner1. 
	■ Your child2 under age 26. 
	■ Your unmarried mentally or physically disabled child of any age, if the child’s disability began before age 26. The disability 
must be such that the child is incapable of self-support and is dependent on you for financial support. 

This information can also be found in the Dependent Eligibility Guidelines posted on eixbenefits.com at Library > Plan 
Information > About Your Benefits > Dependent Eligibility Guidelines. 

1 A registered partner is a person who is:
– Recognized as your registered or certified domestic 

partner by a state which offers the ability to register or 
certify a domestic partnership; or 

– A person of the same gender who has joined with you 
in a civil union that is recognized as creating some or 
all of the rights of marriage under the laws of the state 
or country in which the civil union was legally created. 

2 Child(ren) refers specifically to: 
– Your natural or lawfully adopted children or children placed for adoption with you; 
– Your stepchildren or foster children who qualify as your dependents for income tax purposes under IRS rules; 
– Any other child(ren) who lives with you in a normal parent-child relationship and who qualifies as your dependent for income tax purposes 

under IRS rules; and 
– For purposes of the medical, dental, vision and EAP plans, any child dependent on you for medical support pursuant to a Qualified Medical 

Child Support Order (QMCSO).

 Note: Dependents serving in the military are not eligible for dental or vision coverage.

http://eixbenefits.com
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ARE YOU ADDING A 
DEPENDENT(S) TO 
COVERAGE?

What documentation will I be required to provide when I newly enroll a dependent or re-enroll a previously  
covered dependent?

If you are enrolling a dependent who is your legally married spouse or registered partner, you must provide copies of both 
items listed below: 
	■ A certificate of marriage or registration of domestic partnership. 
	■ Proof that you are still married or registered: Examples of proof include recent copies of joint bank accounts or credit cards, 
your most recent federal/state tax forms listing your dependent, joint leasing or ownership of property agreements, etc. 

If you are enrolling a dependent child, copies of any of the following documents are accepted:
	■ A birth certificate showing you or your spouse/registered partner as the birth parent. 
	■ Court papers showing adoption, legal guardianship or your most recent federal tax form listing the child as your 
dependent. A birth certificate will be required if the court document does not list the dependent’s birth date.

When can a newly-enrolled dependent access services? 

If your eligible dependent is added during Annual Enrollment, your dependent can access services beginning on Jan. 1.  
If you are adding a dependent outside of the Annual Enrollment period, the effective date of coverage is the date of the 
qualifying event. Generally your dependent can access services as soon as your enrollment election is transmitted and 
accepted by the carrier. 

When do I need to submit my dependent verification documents? 

Approximately two weeks after Annual Enrollment ends, you will be mailed a complete package explaining the verification 
process for your newly enrolled dependent. You will generally have 45 days from the date listed on the letter to provide  
the requested documentation before dependent coverage is canceled. The same process applies when new hires, current 
employees or retirees add new dependents (e.g., marriage, birth, etc.).

What if I lost my documentation or have questions about the documents I can provide? 

You may contact the county or state office in which the event took place (e.g., birth, marriage, etc.), or obtain documents 
online by visiting vitalchek.com, which is used by every U.S. state to process vital records requests. That service also has links 
to obtaining documentation from many foreign countries. Some marriage certificates that are dated prior to 1996 may take  
as long as four weeks to retrieve. If you are uncertain about whether you have a dependent that meets the plan’s definition 
for eligibility or have the appropriate documentation, please contact the EIX Benefits Connection for more information. 

If you are unable to  
add a dependent when 
completing your online 
enrollment, it may be 
because additional 
information is required. 
Please call the EIX Benefits 
Connection for assistance.

http://vitalchek.com
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	■ Check to ensure your current providers participate in the Edison Medicare plan you’ll want to enroll in when you turn 
age 65, as some providers who participate in the pre-Medicare plans do not participate in the Medicare plans.

	■ Prepare yourself for the action steps you’ll need to take when you turn 65 by reviewing “You, Edison and Medicare” guide 
available on the EIX Benefits Connection website, eixbenefits.com. 

Medicare is a federal health insurance program for people age 65 or older, and for some people under age 65 who are 
disabled or who have a special condition known as “end-stage renal disease.” Our retiree health care plan options are 
designed to work with Medicare coverage.

If you and/or your covered spouse/registered partner are eligible for Medicare, you must be enrolled in, and remain enrolled 
in, Medicare Parts A and B to participate in one of our retiree health care plans. 

Note: You may defer enrollment in Part B of Medicare if you are actively employed and covered by a company medical 
program by virtue of that employment. This includes coverage you may be enrolled in through your spouse. You will not be 
eligible to enroll in any of Edison’s Medicare retiree plans until you have Medicare Parts A and B.

When you enroll in one of our retiree medical plans, you and/or your eligible spouse/registered partner will be automatically  
enrolled in prescription drug coverage. You should not enroll in individual coverage under Medicare Part D, as this may result 
in the cancellation of your company-sponsored retiree health care coverage. 

You, Edison and Medicare is a resource we provide to address specific details about our plans and Medicare. This document  
is available on EIX Benefits Connection website, eixbenefits.com, and provided with the information you receive when you 
become eligible for Medicare.

If you are enrolled in one of our Medicare plans, and you are required to pay a higher Part D-IRMAA premium, you can apply 
to the Company for reimbursement of the amount of the Part-D IRMAA. Send a copy (retain original for your records) of your 
Social Security statement and indicate you are requesting your Part D IRMAA reimbursement to the EIX Benefits Connection.

If you are eligible for an IRMAA reimbursement, you must submit your reimbursement request by Dec. 31. Only IRMAA 
reimbursement claims submitted for the current plan year and one year prior will be processed. (Example: Only IRMAA 
reimbursement claims submitted for 2022 and 2023 will be reimbursed during the 2023 plan year. Any request for 
reimbursement of coverage prior to the 2022 plan year will not be processed.)

If you are enrolling in a MAP plan, your Medicare information on file will be submitted electronically to the medical plan 
provider. You no longer need to complete MAP enrollment or disenrollment forms.

ARE YOU (OR YOUR SPOUSE/ 
REGISTERED PARTNER) 
TURNING AGE 65 IN 2024?

ARE YOU ELIGIBLE FOR 
MEDICARE?

If you and a covered 
spouse/registered 
partner are a 
combination of 
Medicare-eligible and 
pre-Medicare, you must 
enroll in medical plans 
with the same carrier. 
For example, if you are 
Medicare-eligible and  
elect the Kaiser Senior 
Advantage MAP, your 
pre-Medicare spouse/
registered partner must 
enroll in the Kaiser 
Permanente EPO. 

ARE YOU ENROLLING IN  
A MEDICARE ADVANTAGE 
PLAN (MAP)?

http://eixbenefits.com
http://eixbenefits.com
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ARE YOU ELIGIBLE FOR 
MEDICARE PART B 
REIMBURSEMENT OR  
OTHER INCENTIVE 
REIMBURSEMENT?

	■ PrimeCare retirees that retired prior to Jan. 1, 1989: You may be eligible for reimbursement of the full amount of your 
Medicare Part B premium if you enroll in a PPO option. You must provide proof of the additional amount to EIX Benefits 
Connection each year.

	■ PrimeCare retirees that retired between Jan. 1, 1989 and Dec. 31, 1992: You may be eligible for reimbursement of 
$31.80 (fixed at the Dec. 31, 1992 Medicare Part B premium amount) of your Medicare Part B premium if you enroll in a  
PPO option. 

If you are a PrimeCare retiree, you are eligible for an incentive if you are enrolled in a Medicare Advantage Plan (MAP) option 
and you are either a:
	■ Retiree;
	■ Spouse/registered partner of a retiree; or
	■ Surviving spouse/registered partner of an employee or retiree. 

The incentive is equal to $75 per month if both the retiree and his or her spouse/registered partner are enrolled in a MAP.  
The incentive is equal to $50 per month if only one person — the retiree, the spouse/registered partner of the retiree, or the 
surviving spouse/registered partner of an employee or retiree — is enrolled in a MAP.

Reimbursements for Medicare premiums will be included in your monthly pension check. If you receive a Medicare Incentive, 
you will not receive a reimbursement for Medicare Part B premiums.

Please keep in mind that VSP and Delta Dental do not issue ID cards.  
If you need to obtain an ID card, go to your plan’s website or call their 
Member Services number. You can view all plan websites and phone 
numbers by going to eixbenefits.com at Health > Health & Welfare > 
More > View > Contacts & Helpful Info. You will need to create login 
credentials for your plan’s website if you have not previously done so.

WHAT HAPPENS IF YOU 
DON’T RECEIVE A HEALTH 
PLAN ID CARD, OR YOU 
LOSE YOUR ID CARD?

In 2024, Cigna DHMO will only provide 
physical ID cards to new members. To view 
and print a copy of your digital ID card, log 
into the myCigna® app or website beginning 
Jan. 1, 2024. 

http://eixbenefits.com


14

2 0 2 4  B E N E F I T S  E N R O L L M E N T  G U I D E

EIX Benefits Connection currently uses multi-factor authentication in order to 
further protect your personal information online. With multi-factor 
authentication, you are required to confirm your identity using two or more 
pieces of information before you can gain access to the EIX Benefit Connection 
website. 

When multi-factor authentication was implemented, all EIX Benefits Connection 
users were prompted to re-register new login credentials. If you have not yet 
completed your registration, we encourage you to begin the process now.

To re-register on the EIX Benefits Connection website:

1. Log into eixbenefits.com. 

2. Select Register as First-time User.  

3. Follow the prompts to request a registration key by mail. 

4. Once you receive your registration key, log back on to the EIX Benefits 
Connection website and follow the online instructions to create your User  
ID and Passcode. You will also be able to create security questions and 
authorize your device for future access.

5. Registration keys are only valid for a limited time, so you are highly 
encouraged to log on to eixbenefits.com to re-register a User ID and 
Passcode as soon as you receive it.

The registration process outlined above only affects the eixbenefits.com 
website; it does not apply to the EIX Benefits Connection Interactive Voice 
Response System (IVR). If you call in to the IVR, you can continue to use  
your current login information. 

If you have questions, call the EIX Benefits Connection at (866) 693-4947.  
Representatives are available Monday through Friday, 7:30 a.m. to 5:30 p.m.,  
Pacific time, except holidays. For TDD communication services for the  
hearing impaired, call (800) 833-8334.

EIX BENEFITS CONNECTION — 
REGISTRATION REMINDER

WHAT YOU NEED TO KNOW

Reminder: If you call into the EIX 
Benefits Connection Contact Center  
to speak to a representative, your 
identity must be verified to ensure 
the security of your personal 
information. To secure the call, you 
will be asked to provide your SSN and 
Passcode. Remember: The Passcode 
you use to log in to the Contact 
Center is a different Passcode than 
what you would use to log in to the 
EIX Benefits Connection website.

You can request a reminder of  
your Contact Center Passcode when 
speaking to a EIX Benefits Connection 
representative. The reminder will be 
sent to your email address on file.

To submit or update your personal  
email address, log in to EIX Benefits 
Connection and click on your name  
to access your Profile. Click on the 
Personal Info tab to update your 
personal email address.

http://eixbenefits.com
http://eixbenefits.com
http://eixbenefits.com
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A REVIEW OF EDISON 
BENEFITS

Following is an overview of the benefits we offer, and in some cases, provide to you and your eligible dependents. See the 
“Important Questions and Answers” section on page 10 for our definition of eligibility. The plans available to you may vary 
based on the geographic location of your home address as listed in your profile on the EIX Benefits Connection. To view your 
profile, click on the menu bar in the upper right-hand corner of the eixbenefits.com homepage and select Profile. If you need 
to update your address, click on Change to update your information.

Even if you decide to remain with the same plan and coverage level in 2024, we strongly suggest you review your beneficiary 
designations (and their addresses) to ensure these are up-to-date, as well as your benefit coverages and costs to ensure you 
are enrolled in the plans most appropriate for you in 2024.

In 2024, we will offer the following types of health care plans to you and your eligible dependents:
	■ Medical Plans

 – Preferred Provider Organization (PPO)
 – Health Maintenance Organization 
(HMO)

 – Exclusive Provider Organization (EPO)
 – Medicare Advantage Plan (MAP)

	■ Prescription Drug Coverage
 – Enrollment is automatic if you elect  
one of our medical plans.

	■ Dental Plans
 – Dental PPO
 – Dental HMO

	■ Vision Plan

See the 2024 Health Plans Comparison  
on the EIX Benefits Connection website, 
eixbenefits.com, at Library > Documents  
& Forms > Reference Materials > 2024 
Health Plans Comparison, for details  
about these benefits.

Health Care Benefits

Ensuring Health Care Access In Your Geographic Service Area
The California Department of Managed Health Care (DMHC) governs 
some health insurance providers in the State of California and requires 
health plans to provide sufficient access to providers and facilities within 
a geographic service area (also known as “provider network adequacy”).

When you select a health plan, you need to be able to use it when you  
need health care services. That means there must be enough physicians 
and hospitals in your area who participate in your health plan. The 
physicians and hospitals also need to be close enough so you can  
easily visit them. 

To ensure that you have reasonable access to care in your area, the 
DMHC requires you to select a health plan within your geographic 
service area. Since Edison’s HMO and EPO health plans (with the 
exception of out-of-state plans) are filed with the DMHC, if you have this 
coverage you must select a health plan no more than 30 miles from your 
residence. This is a DMHC requirement and cannot be altered by Edison. 

http://eixbenefits.com
http://eixbenefits.com
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We provide the following benefits to you and any eligible dependents at no cost:
	■ Employee Assistance Program (EAP): Provides short-term confidential counseling for a number of problems, including 
marital and family challenges, emotional or financial issues, personal or job stress, mental health, bereavement, and 
substance abuse. EAP services are convenient, confidential and available 24 hours a day, seven days a week.

You can view the specific benefit options you are eligible for by clicking on your event (e.g., Annual Enrollment) on the  
EIX Benefits Connection website, eixbenefits.com at Work/Life Events > Current Events.

In addition to the information provided here, we offer a variety of resources to help educate you about our benefits,  
the enrollment process, and other important details. The following materials and more, are available on the EIX Benefits 
Connection website, eixbenefits.com:
	■ Health Plans Comparison: Provides a side-by-side comparison of our medical, dental and vision plan options, so you  
can quickly compare key plan features, such as deductibles, copayments and coinsurance. Click on Library > Documents & 
Forms > Reference Materials > 2024 Health Plans Comparison.

	■ Educational Benefit Videos: Each provides a quick and easy overview of a benefit plan or program. Click on Health >  
Health & Welfare > More > Library > Educational Videos.

	■ Summary of Benefits and Coverage (SBC): Each provides a standard summary of benefit coverage levels for the  
pre-Medicare medical and prescription drug plans we offer. Click on Library > Plan Information > Plan Details.

	■ Your Benefits Handbook : Provides details about each of our benefit plans and programs, and serves as our Summary  
Plan Description (SPD). Click on Library > Plan Information > Your Benefits Handbooks.

	■ You, Edison and Medicare: Provides an overview of Medicare and Edison’s retiree health care plans. Click on Library >  
Plan Information > Medicare Information > You, Edison and Medicare.

BENEFIT UPDATE

Other Benefits We Provide

YOUR BENEFIT OPTIONS

Resource Materials

http://eixbenefits.com
http://eixbenefits.com
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We offer simple online tools to help you make informed election decisions. The following are available through the  
EIX Benefits Connection website, eixbenefits.com:
	■ Benefits Mentor: Uses assumptions that you provide about potential health care expenses to help you compare medical 
and dental plans and model costs side-by-side. Click on Health > Health & Welfare > More > Tools > Compare  
Plans/Calculate Costs. 

	■ Locate a Provider: Each carrier gives you the opportunity to search for providers, such as a network doctor, specialist or 
dentist. For providers specific to the plan you are enrolled in, or considering, go to eixbenefits.com, at Health > Health & 
Welfare > More > View > Contacts & Helpful Info, then select the carrier’s website.

Once you submit your elections online during Annual Enrollment, you should save a copy of your Confirmation Statement  
by clicking on Print or Download PDF on the “Confirmation Statement” screen. To print your Confirmation Statement at a  
later date, go to the EIX Benefits Connection website, eixbenefits.com, at Health > Health & Welfare > Benefit Elections.

Shortly after Annual Enrollment ends, you will be mailed a Confirmation Statement, even if you did not take any action.  
The Confirmation Statement will indicate that these elections will remain in effect for the 2024 Plan year. It will also state  
that if there are any discrepancies, you must call the EIX Benefits Connection within 15 days of the date on the Confirmation 
Statement to make any corrections, otherwise the elections will be considered final.

Decision Support Tools

Your Confirmation 
Statement

Continuing Coverage and Divorce
There is no qualifying event that triggers offering COBRA if you voluntarily choose to discontinue benefits coverage for 
dependents during Annual Enrollment. However, if you discontinue your spouse’s coverage during Annual Enrollment or 
due to a change in status in anticipation of a divorce, under certain circumstances, your spouse will be offered COBRA 
continuation coverage from the date of divorce. This means there could be a lapse in coverage as COBRA continuation 
will not be available from the date the coverage was terminated until the date of divorce. The EIX Benefits Connection 
must be notified when the divorce becomes final in order for COBRA to be offered to your former spouse. For 
information about converting to an individual policy, contact your plan carrier.

http://eixbenefits.com
http://eixbenefits.com
http://eixbenefits.com
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CONTACT THE  
EIX BENEFITS CONNECTION

IF YOU HAVE ADDITIONAL QUESTIONS

	■ Through our website, eixbenefits.com :
 – Use the Chat Online feature to communicate in real-time with a representative; or
 – Use the Contact Us feature to send an email to a representative.

	■ By phone at (866) 693-4947
 – Representatives are available Monday through Friday, 7:30 a.m. to 5:30 p.m., Pacific time, except holidays.
 – Questions about Annual Enrollment can be answered during our Annual Enrollment period only. Please be aware that 
wait times on the phone may increase during this time.

	■ Through the Life@Work mobile app
 – You must have a username and password registered for eixbenefits.com before you can register on the app.
 – Download the Life@Work app from the Apple App Store or Google Play.
 – Log in with company code SCE03.
 – Enter your username and password to authenticate your identity and verify your device via email or mobile number. 
 – For assistance, navigate to the Benefits Website tab to utilize the Chat Online feature or the Contact Us feature to 
email a representative. 

http://eixbenefits.com
http://eixbenefits.com
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CONTACTS AND HELPFUL INFORMATION
Plan Type Plan Identifier on ID Card Phone Number Website

Pre-Medicare 
Health Plans

Aetna Nationwide EPO 	■ Actives & Flex Retirees: Open Access Aetna Select
	■ PrimeCare Retirees: Open Access Aetna Select (100%)

(833) 541-8555 aetnaresource.com/n/Edison

Aetna PPO 90/70 	■ Actives & Flex Retirees: Choice POS II (PPO 90/70)
	■ PrimeCare Retirees: Choice POS II (100%)

(833) 541-8555 aetnaresource.com/n/Edison

Kaiser Permanente EPO — (800) 533-1833 (So CA) 
(800) 663-1771 (No CA)

my.kp.org/edison

Pre-Medicare 
Prescription 
Drug Coverage

Express Scripts — for all Aetna 
plans

— (877) 620-6730 www.express-scripts.com/
southerncaliforniaedison

Kaiser Permanente EPO — (800) 533-1833 (So CA)
(800) 663-1771 (No CA)

my.kp.org/edison

Medicare  
Health Plans

Aetna HMO MAP 	■ Flex Retirees: Medicare (S05) HMO (MAP)
	■ PrimeCare Retirees: Medicare (P01) HMO  
(MAP 100%)

(833) 541-8555 SCEMAPlans.aetnamedicare.com

Aetna PPO MAP 	■ Flex Retirees: Medicare (S02) ESA PPO (MAP)
	■ PrimeCare Retirees: Medicare (C04) ESA PPO  
(MAP 100%)

(833) 541-8555 SCEMAPlans.aetnamedicare.com

Aetna PPO Medicare  
Coordinated Plan

	■ Flex Retirees: Choice POS II (PPO 90/70)
	■ PrimeCare Retirees: Choice POS II (100%)

(833) 541-8555 SCEMAPlans.aetnamedicare.com

Kaiser Permanente Senior  
Advantage MAP

— (800) 443-0815 my.kp.org/edison

Medicare 
Prescription 
Drug Coverage

Express Scripts Medicare — for 
Medicare Retirees in an Aetna plan

— (800) 978-6230 www.express-scripts.com

Kaiser Permanente Senior 
Advantage MAP

— (800) 443-0815 my.kp.org/edison

Dental Plans Cigna Dental Care DHMO — (800) 244-6224 www.cigna.com/edison
Delta Dental PPO — (888) 335-8227 www.deltadentalins.com/edison

Vision Plan Vision Service Plan — (800) 877-7195 www.vsp.com

http://aetnaresource.com/n/Edison
http://aetnaresource.com/n/Edison
http://my.kp.org/edison
http://www.express-scripts.com/southerncaliforniaedison
http://www.express-scripts.com/southerncaliforniaedison
http://my.kp.org/edison
http://SCEMAPlans.aetnamedicare.com
http://SCEMAPlans.aetnamedicare.com
http://SCEMAPlans.aetnamedicare.com
http://my.kp.org/edison
http://www.express-scripts.com
http://my.kp.org/edison
http://www.cigna.com/edison
http://www.deltadentalins.com/edison
http://www.vsp.com


The information in this guide does not attempt to 
cover all the details and provisions of the plans. 
This guide serves as a summary of material 
modifications to Your Benefits Handbook. In the 
event of a discrepancy between the information 
contained in this guide and the applicable plan 
documents, the plan documents will govern. 
Edison reserves the right to change or terminate 
the plans or specific plan provisions at any time.

10/2023
TBD
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